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Introduction 

WP Tube Profit Wiz is a plugin that can be used to add a YouTube Video which you 

can then use as monetizer. 

You can insert a YouTube Video into any page or post and you can also add the custom 

content into the video. The content can be text, link, button, or popup optin form 

promos. 

Note: The Lite Version of the plugin lacks the following features: 

1. Restricted Video 

2. Statistic 

3. Optin Form 
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Terms and Rights 

Thank you for your purchase. 

These are your rights to this package: 

 

[ Yes ] For Personal Use Only. 

[ Yes ] May be used on as many WordPress blogs or websites as you own. 

[ No ] May not be used on client sites. 

[ No ] May not be used when blog or website flipping. 

[ No ] Resale Rights. 

[ No ] Master Resale Rights. 

[ No ] Private Label Rights. 

 

Installing 

Download the zipped WP Tube Profit Wiz plugin to your computer. Log in to your 
WordPress site. Hover over the Plugins tab to expand, then click Add New. 

 

 
Select the Upload option 

 

Click Browse 
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Locate the zipped WP Tube Profit Wiz plugin file, select it then click Open. (illustration 
shows a different plugin but process is the same) 

 

 
Your plugin will now be uploaded and installed. Your next step after installation is to 

click the Activate Plugin link 
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Alternative Setup - FTP 

If installing from WordPress does not work for your blog, you may also do it the old 
fashioned way by first unzipping the WP Tube Profit Wiz plugin file to your computer. 

Open your FTP software and upload the entire “wp-tube-profit-wiz” or “wp-tube-profit-
wiz-lite” folder to your WordPress plugin directory which will look like this file path 

inside your FTP software. 
 

http://www.yourblog.com/wp-contents/plugins/ 

 

Once upload has completed, log in to WordPress admin, navigate to Plugins. Locate WP 

Tube Profit Wiz and click Activate. 

 

Simply upload the plugin zip using the WP admin panel browser uploader and activate. 

 

 

Upgrading 

1. First BACK UP YOUR WORDPRESS DATABASE!  We won’t take any responsibility for your 

data, you have to look after it yourself. 

2. Deactivate the existing version of the plugin. 

3. Use your FTP client to delete the existing plugin. 

4. Unzip the new version and save the extracted folder somewhere you can find it. 

5. Use your FTP client to upload the newly extracted folder to your /wp-content/plugins/ 

directory on your WordPress blog or website OR use the new plugin uploader to install 

the upgrade. 

6. Reactivate the plugin. 

 

 

Trouble Shooting 

If your blog or website displays with an error message when you activate the plugin 

or otherwise adversely affects your blog or website, then the first thing you should 

do is delete the plugin with your FTP client or using the delete function on the 

plugins page, and your blog or website will be restored to normal. 

  

http://www.yourblog.com/wp-contents/plugins/
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How to Use WP Tube Profit Wiz 

This guide assumes that you have already logged in to your WordPress Admin 

Dashboard and that you have already installed and activated WP Tube Profit Wiz. 

Once the plugin has been activated, you should see from the left admin panel its 

plugin option. 
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How to Create a New Video 

The following steps describe the process of creating a new Tube Profit Wiz Video. 

1. Start by moving your cursor over to the menu item of the plugin in the left admin 

panel and click the Add New link. You can also click the “Create New” menu item, 

which you can find at the plugin’s Dashboard as shown in the image below.  

 

 

 

2. This should open up the Create New page where you will start adding the General 

Information to build the desired video as shown in the screenshot below. 
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 Title. Specify a unique name that will enable you to distinguish this video from 
the other videos that you create. 
 

 YouTube URL. Specify the URL of the YoutTube Video. 

 

 

 Video Autoplay. Determines whether the video will automatically run when the 

page is loaded without having to click the play button. 

 

 Video Start Time. Determines the the initial time (in seconds) that will serve as 

the starting point when the video is run. 
 

 

 Status. Determines whether the video will be displayed in the page or not. 

Once you are done filling up the above fields, click on one of the Add Video Buttons 

to proceed to the next steps. 

Once you click the Add Video Button and the video is successfully saved for the first 

time, other Tabs will show up under the General Tab as shown below. 

 
 

 
The guide on how to fill out the fields corresponding to each Tab (Design, Top Content, 

Bottom Content, Restricted and Statistic) will be discussed in a later section of this 
document. 

But first, let’s learn how to edit your newly created video.  
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How to Edit a Video (General Tab) 

Editing WP Tube Profit Wiz Video involves just four easy steps. 

1. Go to the Video List Page by clicking the All Videos Link under the WP Tube Profit Wiz 

link found in the sidebar as shown in the screenshot below.  

 

2. From the list of videos displayed, click on the right-most button found in the same 

row as the video that you want to modify. 

To understand better, please refer to the image shown below. 

 
 
3. You will be taken to the Video Edit Page where the General Settings of the video is 

shown. 

 

Make the necessary field entry changes that you want to apply on that particular Tab, 
or navigate to the other Tabs to modify the field settings corresponding to that group. 

The other Tabs will be discussed in the next section, but the process is similar. 
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4. Once you are satisfied with the settings, click on the Save Changes Button for the 

modifications to take effect. 

Please refer to the screenshot below to see where the Save Changes Button is 

located. 
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The Design Tab Settings 
The Design Tab Panel 

The Design Tab Panel consists of two sections that function as follows: 

 Design Section -- allows you to set the look and feel of the elements 

surrounding the video. 

 Popup Section -- allows you to set the style of the Popup Window that shows 

up when you click a particular button that you set in the Top Content Box Tab 

and Bottom Content Box Tab, which will be discussed at the later parts of this 

document. 

 
The Design Section 
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The Design Section has the following settings that allow you to control the 

appearance of the video and its surrounding elements: 

 Video Width – sets the width of the video in pixel units. 

 Video Height – sets the height of the video in pixel units. 

 Video Padding – sets the distance around the video in pixel units. 

 Background Color – sets the background color of the area behind the video. 

 Background Image – sets the background image that shows up behind the video. 

 Background Repeat – sets how the background image (set above) is to be 

rendered. 
 Border – sets the color and size of the border around the video. 

 Border Radius – sets level of curvature of the border line. 
 

The Popup Section
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The Popup Section has the following settings that allow you to control the 

appearance of the Popup Window. 

 

 Width – sets the width of the popup box in pixel units. 
 Height – sets the height of the popup box in pixel units. 

 Font Family – sets the font-type for the text content in the popup box. 
 Text Color – sets the color of the text content in the popup box. 

 Background Color – sets the background color of the popup box. 
 Background Image – sets the background image of the popup box. 

 Background Repeat – sets how the background image appears in the popup box. 

 Border – sets the border color and width of the border around the popup box. 

 Border Radius – sets the level of curvature of the border around the popup box. 
 Button Style – sets the style of the popup box button. 
 Button Color – sets the background color of the popup box button. 

 Button Size – sets the size of the popup box button. 
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The Top (Bottom) Content Tab Settings 

Note: The Top Content Tab and the Bottom Content Tab both share similar and 

common settings. This part of the document explains the settings that are applicable 

to both. The Top (Bottom) Content refers to the content box that appears at the top 

(bottom) of the video. You can control the general appearance of this content box by 

setting the appropriate options contained in the Top (Bottom) Content Tab 

Settings as shown below. 
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As you can see, the Top (Bottom) Content has five (5) sections, namely: 

1. General – controls the overall appearance and style of the content box. 
2. Title – controls the appearance of the Title text of the content box. 

3. Subtitle – controls the appearance of the Subtitle text of the content box. 

4. Info – controls the appearance of the text message that appears in the content 

box. 

5. Button – controls the appearance of the button located at the bottom of the 

content box. 

The Title, Subtitle, Info sections all share common settings and so they are explain as 

one here. 

 
The Content Box General Settings 

 

 Show/Hide Top Content – determines whether the top content box is to be 

displayed or not. 
 Background Color – sets the background color of the content box. 

 Border – sets the color and size of the border around the content box. 

 Auto Hide Content – determines whether the content box automatically hides or 

not when the mouse pointer is hovered on top of the video. 

 Show/Hide Close Button – determines whether or not to display a close button at 

the top right portion of the content box. 

 
The Title / Subtitle / Info Settings 

 Show/Hide Title/Subtitle/Info – sets whether or not the text for the 

title/subtitle/info. 

 Title/Subtitle/Info – sets the text that appears as the title/subtitle/info of the 

content box. 
 Font Size – sets the font size of the text. 

 Font Family – sets the font style of text. 
 Color – sets the color of the text. 
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The Button Settings 

 Show/Hide Button – determines whether to display or not the button at the 

bottom of the content box. 
 Button Label – sets the text that appears as the label of the button. 
 Button Style – sets the style of the button. 

 Button Color – sets the color of the button. 

 Button Size – sets the size of the button according to some pre- determined 

values. 
 Font Family – sets the font type of the text that appears in the button. 

 Action – sets the action that will happen when the user clicks on the button. 

Action can be set in any of three (3) options listed below. 

 

 Redirect to URL – simply redirects to the set URL page. 
 Display Opt-In Form – pops up a window showing an Opt-In Form. 

 Display Popup – displays a popup box whose settings were discussed above 

under the Design Tab Settings. (Please refer to pages 10 and 11 to review the 

settings.) 

Each of these three settings is describe in more detail in the succeeding paragraphs 

immediately after this. 
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Redirect to URL 

 

This is the simplest option. Simple specify in the URL text box the URL of the page 

resource where you want to redirect the user when the button is clicked. 

 

Display Opt-In Form 
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When this is selected, then the user will be presented with an Opt-In Form whose 

fields and other details are set as follow.Form Title – specifies the title of the Opt-In 

form. 

 
 Form Info – describes the Opt-In Form in detail. 

 Form Code – this should contain the Raw HTML Code for theOpt-In Form of 

the client’s Autoresponder service. 

 Action URL – specifies the URL of the Opt-In Form’s Action. Most of the time, 

this is automatically pre-populated after the Raw HTML Code is embedded in 

the Form Code above. 

 Form Email Field – specifies the email field of the Opt-In Form. Most of the 

time, this fieldset is automatically pre-populated after the Raw HTML Code is 

embedded in the Form Code above. 

 Form Name Field -- specifies the name field of the Opt-In Form. Most of the 

time, this fieldset is automatically pre-populatedafter the Raw HTML Code is 

embedded in the Form Code above. This fieldset can be set to display or not. 

 Show/Hide Form Label – determines whether or not to display label of 

eachform field. When set to hide, the label becomes a placeholder of the input 

field. 
 Submit Button Text – sets the text or label of the Submit Button. 
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Display Popup 

 

When this action is selected, the user is then presented with a popup box that displays 

when the user clicks on the Top/Bottom Content Button. This popup box can be 

used to present product offerings or any message that you want to show to the visitor. 
 

Its setting 

options are as follow. 

 Title – specifies the title of the popup box. 

 Image – specifies the image that will be shown in the popup box. 

 Image Link URL – specifies the URL to which the user will be redirected when he 

clicks the Image. 
 Info – specifies the text content of the popup box. 

 Button Label – specifies button label that appears below the popup box. 

 Button URL – specifies the URL to which the user will be redirected when the 

popup box button is clicked.  
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The Restricted Tab Settings 

 

 
 

The WP Tube Profit Wiz Plugin can be set so that only authenticated users are able 

to see the video and this is made possible with the settings available in this section. 

 Restricted User – determines whether the video is available only to authenticated 

users or the public as well. 

 Restricted Message – sets the message to be displayed to users who are not 

allowed to view the video. 
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The Statistic Tab 

This section can be used to view statistical information that result from the user’s 

interaction with the video objects that were embedded into the page or post. 

The following statistics are available: 

 Views – shows the number of users who have seen the video. 

 Subscribe – shows the number of users who have been using the Opt- In Form. 

 Popup Button Clicks – shows the number of users who have clicked the button / 

link in the popup box. 

 Button Clicks – shows the number of users who have clicked the button / link 

redirect. 
 

How to Delete a Video 

Deleting a video involves three steps. 

1. Click on the All Videos Link from the WP Tube Profit Wiz located at the Sidebar of 

the WordPress Admin Dashboard. 
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2. From the list of videos presented, navigate until you see the video that you want to 

delete. Click on the right-most button along the same row as the video, then click the 

Delete Video Button that shows up as colored red. 
 

 

 

 

3. A Popup Window will appear prompting you to proceed or cancel the video deletion 

process. Click the Yes Button to proceed and so delete the video. Or, click the Cancel 

Button to abort the process. 

 

 
 

 

 

 

 

 

  



25 
 

How to Embed a Video into a Page or Post 

Embedding a Video into the any post or page is very easy. Please follow the steps 

outlined below. 

1.Make sure that your user profile allows you to write a page or post in Visual Mode as 

opposed to the Text Mode. You can check this by viewing your Use Profile Page and 

unchecking the Visual Editor Box as shown in the screenshot below. 

 

 

2. Create or Edit the Page or Post where you want to embed a video from the default 

WordPress Editor. Make sure that you are in Visual Editor Mode and check if the WP 

Tube Profit Wiz Shortcode Icon is present in the Menu Bar, as shown below. 

 

 

3. Position the cursor where you want the video to appear in the post/page, and then click 

on the WP Tube Profit Wiz Shortcode Icon. 

 

4. A Popup Window then appears that allows you to select the video that you want to 

embed in the page as shown below.  
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How to Embed a Video into a Page or Post (continued) 

 

 

5. Click on the Insert Video to generate the WP Tube Profit Wiz Shortcode and embed 

it directly in the post/page at the position of the cursor as shown below. 

 

 

 
6. Don’t forget to save the post or page for the changes to take effect. 
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Resources 

Namecheap.com 

Cheap domain registration with an excellent control panel for managing all of your 
domains. 

Hostgator.com 

Best hosting company in the business. 

Aweber.com 

Hands-down one of the best services online for managing your email newsletter. 

OptimizePress  

A WordPress Theme, and yet so much more to Build High Converting Squeeze Pages, 
fast. Create Powerful Product Launches. Use it to Build Awesome Membership Sites.  

Build Your blog or website. Build Sales Letters, Bonus Pages, One-Time Offer Pages & 
More. Simple Autoresponder Integration. Add Video To Your Pages In Seconds. Secure 
Your Membership Areas. 

Gateway Launch System. Create Perpetual Launches. Easy to Follow Training & 
Tutorials. Facebook Comments & Sharing. Social Sharing Built-in. Add Your Headlines, 
Text and Bullets in Seconds. Integrated SEO Features. Cross Browser Compatible. 

 Award-Winning Support. 

Top Notch Plugins 

Plugins tested and proven to work. 
 

Killer PLR 

Unique Done-For-You Business In A Box. 
 

Software Of The Week 

Our best software recommendations for each week. 

  

http://www.namecheap.com/?aff=44792
http://secure.hostgator.com/~affiliat/cgi-bin/affiliates/clickthru.cgi?id=cjsuccessteam
http://aweber.com/?364238
http://nanacast.com/vp/97647/88822/
http://yourimhelper.com/go/Recommends/ResourceTopNotchPlugins
http://yourimhelper.com/go/Recommends/ResourceKillerPLR
http://yourimhelper.com/go/Recommends/ResoucesSoftwareOfTheWeek
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Freebie Of The Week 

A new super freebie package every week. 
 

FileZilla 

Free FTP software (I use this on a weekly basis to upload new files and pages to my 
website.) 

Zamzar.com 

A Free online conversion tool that allows you to convert nearly unlimited types of media 
file formats, including documents, images, audio, videos, etc… Convert your files to 
different formats quickly and easily. 

Ninjawarriorvideotips.com 

Want to know how to create videos like the pros. When you become an expert video 
marketer you’ll be able to transform your entire online business and increase your profits 
astoundingly. 

WP Checklist Maximizer 

This is a scalable task management system that plugs directly into your WordPress blog 
or website. You really have to see it to appreciate. 

Instant Action Profits 

WP Affiliate Program so easy that a 5 year old could set it up, no more excuses now, so 
get your affiliate program up and running today! 

Profits Theme 

Leverage your time and make profitable WordPress Sites in minutes. 

Payspree (Merchant Account)  

Instant commission affiliate network. 

Wordtracker (Keyword Tool)  

Keyword research made easy.  

http://yourimhelper.com/go/Recommends/ResoucesFreebieOfTheWeek
http://download.cnet.com/FileZilla/3000-2160_4-10308966.html
http://www.zamzar.com/
http://www.ninjawarriorvideotips.com/
http://www.warriorplus.com/linkwso/nsnm7z/6408
http://www.warriorplus.com/linkwso/ccmzmr/6408
http://www.getprofitsfast.com/member/go.php?r=3054&l=http://profitstheme.com
http://payspree.com/4375/netfair1
http://payspree.com/4375/netfair1
http://affiliate.wordtracker.com/n/5r06vq1BAAMRBmM2OTkA-A/g/freekeywords.wordtracker.com
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Authors: Chris Jenkins & Monika Morley 
 

Visit us at :  http:// topdogimsoftware.com 

 
 
 
 
 
 
 
 
 
 
 

 

 Chris Jenkins  Monika Morley 

 

Known by some as The IM Helper, Chris has over 5 years of online experience, initially specializing 

in Internet Marketing. Chris, among other things, has a good deal of experience with SEO. To give 

you a taste of his abilities, Chris takes a mere 2.5 minutes, to get any website on Google Page 

Rank 1, unbelievable, but true. 
 
Products like Chris' Massive Traffic Profit System, WSO Quick Funnels, List Building Super Nova, 

are just a few examples of his product ideas. While some products, like RSS Link Wheel Sage, 

PingFM Poster, Stealth Backlink Sniper, Redirect Buddy, Optin-Wiz, and many others are products 

that Chris helped develop with partners. Chris is always open to new ideas from potential partners 

on products. 
 
CJ Success Team LLC, Chris' company, has been and remains, an eBay PowerSeller, often with 

his wife Camille at the helm of these endeavors. Chris' wife and family are all integral parts of his 

company and his Internet businesses. 
 
Most recently, Chris has been launching WSOs (Warrior Special Offers) on the Warrior Forum. Chris also 

participates in a great many smaller projects, such as enormous Giveaway and Mini-Giveaway events, 

where he consistently dominates the leader boards. Quoted from a private source, Chris managed to add 

40,000 subscribers in only 7 months. 
 
Monika has been running her own Online Business since 2010 and specializes in List Building, 

Email Marketing, Product Creation and JV Management. Her key factors to success include 

establishing Joint Venture Partnerships with Top Marketers and Product Creators, like Chris 

Jenkins, Chad Nicely, and Rob Maggs (to name a few) and plays a leading role in implementing 

successful Product Launches. 
 
Monika's personal strategy ensures customers get Top Class Information Products and Tools. She 

Researches, Analyzes, Tests, Communicates, Creates, Connects and provides Support. This develops 

long lasting relationships with marketers at all levels and provides clients with up to date information, 

strategies, and tools that are proven to work in various niches. Helping Partners, Affiliates and 

Customers succeed is Monika's main goal. 


